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Abstract 

 

The following thesis deals with BIM methodology implementation in Taormina 
underground railway station. The thesis is focused on the modeling of the 
Mechanical, Electrical, and Plumbing equipment (MEP). The main goal of the 
thesis is to elaborate a model that follows as accurately as possible and finally 
propose a framework of the Building Information Modelling (BIM) - Building 
Management Systems (BMS) data conversion method to open JSON database to 
improve the handling and storage of the building data. So, the objective is after 
modeling the components of elements, to try to understand how to make the model 
available for the interaction with BMS systems. In another word, the focus of the 
thesis is to export the model in JSON language to make it available in any kind of 
platform for facility/asset management.  

 

The thesis is divided into different chapters that follow the chronological order of 
development of the thesis. First, it includes some BIM methodology background, 
especially focused on the Building Information Modelling (BIM), Facility 
Management (FM), and integration between these two main platforms and then 
develops into a real application of this methodology. After a brief introduction, 
we will focus on the parametric modeling of the case study, and then export the 
model into the Navisworks for clash detection and finally pass into the Dynamo 
and try to export it in the JSON format that is linked to the Building Monitoring 
Systems (BMS). In conclusion, this thesis represents a practical application of the 
BIM methodology to a real case study. 
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1 Introduction  

This chapter introduces an overview of BIM and FM. The research objectives and 
work methodology that the thesis will follow are presented as well. 

1.1 Overview 
BIM (Building Information Modeling) is a potential advancement in the field of 
Architecture, Engineering, and Construction (AEC) that first emerged in the early 
2000s in the United States [16]. BIM technology enables the creation of a digitally 
accurate virtual model of a building, and it is regarded as a methodological 
process for construction projects as well as an innovation that adds significant 
improvements in the field of construction, throughout the work's life cycle, 
facilitating the development of the various construction steps of the project, from 
conception to construction and use, and finally demolition. In addition, the use of 
BIM improves production and efficiency. BIM technology was first used in 
building construction design, and as a result, many standards and software 
programs were designed and developed to aid interoperability. The use of 
InfraBIM has grown in popularity around the world as infrastructure projects have 
become more complicated [30]. 

Facilities Management (FM) is a broad profession that emerged in the 1970s in 
conjunction with the outsourcing of services in the United States of America 
(USA). Its key goals are to create a quality environment and to respond to 
businesses' need for a competent and specialized single-point-of-contact who can 
optimize all internal service management activities that support the business [4]. 

BIM is ready to provide a new degree of functionality for building FM as well as 
physical assets in an era of increasingly complex and current technologies. 
However, before implementing integrated BIM in FM, the power manager must 
thoroughly examine numerous aspects, including personnel management, 
communication protocols, procurement, cost control, risk management, and an 
overarching BIM strategy [3]. 

FM can be characterized in a variety of ways, including financial and asset 
management, operations and maintenance facilities, and even 'fast track' 
management and planning methods [43]. Data connections from design, 
construction, and renovation can be used for the operation and lifecycle 
management of buildings, assets, and facilities when FM and BIM are integrated. 

By reading related material, such as Teicholz's book (2013) [46] "BIM for Facility 
Manager," the author obtained a broad understanding of BIM/FM integration and 
its benefits and challenges. 
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1.2 Research Objectives 
The major goal of this thesis is to better comprehend the development of a BIM 
model (management and maintenance) with the integration of a field monitoring 
system for an underground railway station's ventilation and smoke control 
systems. 

Integration with Computer-aided Facility Management systems (CAFM) to 
organize and update maintenance activities in connection to the model's 
components may be required when developing a BIM model for the management 
and maintenance of ventilation systems. The database of the management BIM 
model's potential lies in its capacity to be interrogated and exported in various 
forms, allowing it to connect to other information systems. The data, which is 
organized and structured according to a particular hierarchy, may thus be 
implemented and updated throughout the work's life cycle and shared among the 
many stakeholders. 

 

Figure 1 Cloud Platform for Facility Management Services  

(Source: https://bimon.it/blog/piattaforma-cloud-facility-management/) 

The management model created by combining BIM and CAFM platforms can be 
used as follows: 

 integrated technical and documental knowledge database of the plants in 
question; 

 the tool that simplifies the search for graphic and alphanumeric 
information; 

 support to the design of new works; 
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 mapping of spatial, functional, and hierarchical relations of the equipment; 
 tool for traceability, analysis, design, and optimization of 

ordinary/extraordinary maintenance interventions; 
 transfer of cognitive and maintenance know-how from the supplier to the 

ownership and coordination of the operators' activities; 
 mapping and verification of safety aspects; 
 a key tool for instruction at all levels, particularly through augmented and 

virtual reality applications. 

1.2.1 Integration BIM - BMS - CMMS 
Asset information must be easily accessible to improve the performance and 
efficiency of O&M activities. To facilitate those tasks and store asset data, FM 
currently uses two types of systems: 

Both automated facility and real estate management are supported by the 
Computer-Aided Facilities Management (CAFM) technology. It is used to 
organize and monitor activities that occur across the facility by interacting with 
various platforms such as Computer-Aided Design (CAD), BIM models, and 
relational databases. It has a variety of facility management features, including 
space management, schedule repairs, preventive maintenance, and work orders 
monitoring. 

The Computerized Maintenance Management Software (CMMS) system has as 
its objective the management of maintenance activities. It is regarded as a 
maintenance-only component of CAFM software. Engineers can have complete 
control over resource availability and work allocation with CMMS systems. A 
comprehensive maintenance process is provided by CMMS systems, which 
include resource records, parts/stock systems, and ordering systems. 

Building Management Systems (BMS) are systems that monitor and regulate the 
equipment and electrical resources in a structure. Security systems, fire protection 
systems, electricity systems, temperature management, and other similar systems 
are examples of these. For further performance monitoring and maintenance 
management, BMS systems are frequently linked to other applications. 
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Figure 2 Integration BIM - BMS – CMMS 

(Source: https://docplayer.net/22855063-Improve-efficiency-and-reduce-clutter-with-bim-for-
fm.html) 

1.2.2 Digital Twin 
Starting with the concept of a management BIM model as an information 
repository that will be implemented over time, the development of a digital twin 
allows for the detection and monitoring of changes via physical components, as 
well as the specification of implementations via virtual components. The creation 
of a network of sensors for monitoring physical components is aimed at 
establishing a structure for dynamic knowledge control and its use inside the BIM 
environment for updating the management model. 

The BIM model in Revit and the CMMS files both contain distinct information 
for the same power components and do not appear to be directly compatible. By 
combining the two resources, a more detailed and functional model of the building 
will be created, combining the visual advantages of the BIM model with the 
valuable maintenance information in the CMMS system. Extracting information 
from both files and creating a link between the data formats are required to make 
the two sets of data interoperable. The data from each source must be translated 
to a compatible format before Revit and CMMS may communicate information. 
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Figure 3 Digital Twin  

(Source: https://www.semanticscholar.org/paper/Towards-a-semantic-Construction-Digital-
Twin%3A-for-Boje-Guerriero/ebec2668e6d82a4bc5f55882beb39592d33ba59d) 

The objective is to keep an eye on the ventilation systems and collect data from 
their many components. For example, if a system fails or is damaged, a type of 
alarm from building monitoring systems (BMS) should be sent to the building 
information model (BIM). To put it another way, if the systems fail, how can the 
failure or damage of the systems be reported by BMS and then filtered to show 
this alarm or problem mirrored in the BIM model, such as by highlighting the 
damaged BIM elements in red. 

As a result, we must understand how information can be transferred from a 
physical asset to a digital model. It is important to implement a middleware 
system to integrate BIM authoring on one side and the CMMS system on the 
other. One option is to use the JSON language, which is a programming language 
that may be used to exchange data between these two main domains, BIM 
authoring, and the CMMS system. Because it is not possible or useful to create a 
direct connection between BIM authoring and CMMS system since data from 
BIM authoring is not properly set to be integrated with this platform and also 
requires different integration of two types of databases, a middleware system is 
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required to create the connection between BIM model and what is monitored from 
physical assets.  

The time- and computational-intensive analytical process can be aided by proper 
data formatting and integration of BIM-BMS data. Data-exchange formats like 
JavaScript Object Notation (JSON) are not only simple to create and interpret, but 
also for humans and machines to read. The capacity to convert large, dynamic 
datasets into a language-independent text format can be applied to both difficult 
mathematical procedures and pattern visualization for FM specialists, occupants, 
and owners [45]. Simple data formats, such as JSON, are frequently used for 
transferring highly dynamic data [1], such as sensor data, since they are simple to 
read and interpret with little to no storage needs, and queries to massive 
operational databases are faster. When describing complicated things with basic 
data, JSON's simplicity is favored [25]. 

 

Figure 4 Integration Between BIM and CMMS 

The core objective, as indicated in Figure 4, is to export data and parameters using 
JSON language to combine a BIM model with a BMS system. This gap was 
discovered through study and the researcher's reflections on day-to-day 
experiences. A case study of an underground railway station is also carried out to 
see if combining Revit with a CMMS system is feasible. 
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1.3 Case Study 
This thesis' case study is a type of typological underground railway station. It is 
not permitted to specify the project and related documents in public because the 
entire project has not yet been completed. The author will produce a part of the 
disciplinary model relating to the ventilation system and the other model including 
the fire protection system is created in the thesis of colleague Taraneh Memar. 
The following section will go over some basic ideas in BIM methodology and 
how they are used in an infrastructure case study.  

1.3.1 MEP Systems 
The mechanical system, often known as the Heating, Ventilation, and Air 
Conditioning (HVAC) systems, of an underground railway station, is the subject 
of this thesis. 

MEP stands for mechanical, electrical, and plumbing engineering. As a result, the 
MEP model is the model that contains all of the information about a project's 
design, construction, interventions, and maintenance of a facility's systems and 
subsystems. The MEP systems in the facilities not only support our everyday 
demands but also play a critical part in the construction of a comfortable 
environment inside the structures. MEP refers to everything that has to do with 
the non-structural aspects of a structure's functioning. MEP engineering is a 
significant aspect of a facility and has a direct impact on efficiency, safety, and 
energy use [51]. 

MEP engineers are in charge of making the interiors of buildings comfortable. 
These engineers must deal with a variety of issues, including spatial coordination, 
the efficient operation of parts in a system or installation, as well as testing and 
maintenance procedures [19]. 

All systems linked to heating, ventilation, and air conditioning (HVAC) are 
considered mechanical systems. Other systems, such as lifts, escalators, or other 
forms of transportation, can, nevertheless, be included. Their goal is to keep the 
air quality high by managing temperature and humidity. Oversizing mechanical 
systems have undesirable implications, such as temperature fluctuations, rapid 
degradation, and poor humidity control [47]. 

MEP systems have become increasingly complex throughout time to meet 
advanced design and the needs of new facilities, necessitating additional space 
and coordination for installation. On the other hand, the amount of space available 
in buildings is constrained by cost and energy efficiency concerns. As a result, 
coordinating MEP systems in large buildings and infrastructures has become a 
particularly tough challenge [31]. 
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Mechanical BIM MEP design was born and developed at the same time as 
architectural and structural BIM design models; in fact, only an overview of the 
building-plant system allows for evaluation of the dimensional and spatial 
coherence of the plants within buildings, as well as the avoidance of errors and 
interference [44]. 

The ability to combine a BIM MEP model with an architectural/structural BIM 
model is the starting point for a basic plant solution, which then allows for the 
creation and modification of MEP 3D plant structures (ducts, pipes, emission 
terminals) based on the architectural model, allowing for perfect coordination 
with the virtual model of the building and its modifications. From the preliminary 
through the final management and management phases of the work, the value of 
an integrated design is seen in terms of cost savings, time, and control over the 
project [29]. 

1.4 Work Methodology 
The MEP model is created in the early step using Autodesk Revit 2020. After that, 
the model is exported as a Navisworks NWC file. Using the Clash Detective tool 
in Autodesk Navisworks Manage 2020, we can check for any clashes between the 
ventilation system model and other models, such as the fire protection system 
(created in the thesis of colleague Taraneh Memar). As a result, any geometric 
interferences between the models can be highlighted via clash detection. In the 
event of a clash or error, the findings are reported, and the model must then be 
modified. If there are no clashes, we can send the model into Dynamo and attempt 
to export it in the JavaScript Object Notation (JSON) format that is linked to the 
Building Monitoring Systems (BMS). The JSON format is a lightweight data-
interchange format that is simple to read and write for people and easy to 
understand and create for machines. 

The flowchart in Figure 5 depicts the technique used during the current thesis 
study, and it is summarized in the following main steps: 

 Input: Collection of input data about the projects; 
 Modeling: create the MEP model in Autodesk Revit 2020; 
 Export:  Start to export the model in Autodesk Navisworks Manage 2020; 
 Validation: Check any interferences via Clash Detection; 
 Output: Using Dynamo to export into the JSON format. 
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Figure 5 Methodology Workflow 
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2 Literature Review  

This chapter summarizes the extant literature on the thesis's topic area. The 
definition and procedure of developing building information modeling are 
introduced in the first section of the chapter. The BIM dimensions, 
interoperability between software programs, level of development for information 
models, data sharing environment, and finally the usage of BIM for facility/asset 
management are covered in the following sections. 

2.1 BIM Definition 
BIM stands for Building Information Modeling. Dr. Charles Eastman of Georgia 
Institute provided an early definition of BIM. "Building information modeling 
combines geometric model data, functional needs and capabilities, and piece 
behavior data into a single, interconnected description of a building project 
throughout its lifecycle. It also contains process data for construction schedules 
and production processes" [21]. 

BIM, according to the National Building Information Modeling Standard 
(NBIMS), is "an improved planning, design, construction, operation, and 
maintenance process employing a standardized machine-readable information 
model for every facility, new or old, that comprises all relevant information 
created or gathered by this facility in a format that may be used by anyone at any 
time during its life cycle" [39]. 

"Building Information Modeling (BIM) could be a combination of interacting 
policies, processes, and technologies providing a plan to manage the fundamental 
building design and project data in digital format throughout the life-cycle of the 
building," according to another definition [14]. 

Figure 6 illustrates a different meaning of BIM. 

 

Figure 6 Some Common Connotations of Multiple BIM Terms [14] 
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Increased efforts are being made to take advantage of BIM's benefits to improve 
the operation and maintenance phases of a building's lifetime [18]. With the 
advent of smart building technologies, several structures are being supplied with 
intelligent building automation systems that use a variety of sensors to gather vast 
amounts of data [33]. It is possible to combine real-time data collected and 
aggregated by sensors with geographical information retrieved from a BIM 
model. This integration may be beneficial in assessing the performance of 
building systems and in making decisions concerning facility management and 
operations [33]. 

2.2 BIM Dimensions  
BIM is also known as n-D modeling, and Oraee et al. characterized it as a 
"technological and management methodology" [7]. BIM was first employed 
because of its digital parametric modeling capabilities, which demonstrated its 
superiority over CAD. However, BIM eventually stopped addressing the 
dimension associated with geometric modeling, instead of adopting an n-D 
approach: time was added as a fourth dimension, and costs were added as a fifth. 
The sixth component of BIM is sustainability, project life cycle, energy, safety, 
facility, and construction management. Sustainability and facility management 
are options for the seventh dimension, while some publications refer to the eighth 
dimension of BIM as accident prevention, for example [4]. 

The following classification is based on the UNI 11337 standards, which are 
voluntary technical standards adopted in the Italian context for the digital 
management of construction information processes: 

 3D - Three-dimensional modeling: the building object is displayed during 
its entire life cycle using the "traditional" 3D visual model. It is feasible to 
successfully manage modeling in this way, eliminating errors in both the 
design and execution and maintenance phases; 

 4D - Time management: this dimension allows for the planning of time 
management, or a sort of associated work schedule, to the model to 
decrease the risk of process disruption during the project's life cycles. 
Furthermore, during the life of the building, the times and coordination of 
the personnel are engaged; 

 5D - Economic management: using a 3D model and 4D BIM, the fifth 
dimension enables for complete cost control throughout time. This option 
enables for the creation of efficient structures; 

 6D - Life cycle and maintenance: the sixth dimension enables the 
management and maintenance of a construction object over its entire life 
cycle to be optimized; 
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 7D - Sustainability: this dimension includes an analysis of the building's 
energy consumption. Analyzing the energy performance from the 
beginning enables the implementation of solutions that ensure lower energy 
consumption and, as a result, project sustainability. 

Figure 7 shows the dimensions of BIM. 

 

Figure 7 The Dimensions of BIM   

(Source: http://www.pinterest.com/pin/849491548436309669//?d=t&mt=login) 

2.3 Interoperability 
The information models created or modeled throughout the BIM process must be 
shared among software programs. From the construction phase to the end of the 
structure's useful life and demolition phase, interoperability allows all specialists 
involved in the design to have access to all relevant information and share it [17]. 

The National Building Information Modeling Standard (NBIMS) states that 
adopting an open data model of facilities and a corresponding interface to that 
data model for each participating application is required for successful software 
interoperability in the capital facilities sector. The software applications of each 
industry can be made interoperable if the adopted data model has industry-wide 
properties (i.e., represents the complete facilities life cycle) [39]. 
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Figure 8 The Interoperability Concept  

(Source: https://biblus.accasoftware.com/en/buildingsmart-and-bim-digital-award-two-
important-awards-to-acca-software/) 

IFC Standard 

BuildingSMART, a worldwide organization, maintains and develops the Industry 
Foundation Classes (IFC) file format. The IFC is open-source international 
standards, allowing them to be readily adopted by software [30]. IFC is a software 
interoperability solution that allows different software programs to communicate 
with one another. Throughout the life cycle of a building, IFC increases 
communication, productivity, delivery time, and quality. With established 
standards for common objects in the construction sector, it prevents data loss 
while transmission from one application to another. 

UNI EN ISO 19650 

The Italian versions of ISO, UNI EN ISO 19650-1: 2019, and UNI EN ISO 19650-
2: 2019, are the international standards to be referred to in the context of BIM 
design. Part one includes background information and defines the ISO 19650 
principles for information management. It also consists of a series of 
recommendations for the actors participating in the design process that is always 
related to information management, such as sharing, registration, updating, and 
organizing. The standard covers the whole work life cycle, including strategic 
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planning, preliminary design, engineering, development, assignment and 
construction documentation preparation, daily operation, maintenance, 
restoration, and repair. The standard can also be adjusted to fit any size or 
complexity of the structure. Part two lays out the requirements for information 
management and exchange during the work's delivery phase. Regardless of the 
procurement approach, this section can apply to all types of construction and all 
types and sizes of organizations. These international standards apply in 
conjunction with UNI 11337, which is a complimentary standard. 

UNI 11337 

The UNI 11337 standard is a ten-part document that addresses the management 
of construction information processes, specifically models, documents, and 
information objects for products and processes, model evolution and information 
development, and flow information in digital processes. 

2.4 LOD/LOIN 
The Level of Development (LOD) specification allows industry professionals to 
describe how an element's geometry and accompanying information have 
changed over time. It reflects how much various members of the team can rely on 
information related to a specific element. In reality, LODs indicate the quantity of 
valuable information required to meet the BIM operator's expectations during 
each design phase [35]. 

In recent years, the construction industry has paid more attention to information 
management, thanks in part to the continued development of BIM systems. A 
project's management is divided into numerous phases, ranging from design to 
maintenance, each of which necessitates a particular amount of data [35]. The 
data's Level Of Development (LOD) is determined by the project team and is 
provided in the Model Production and Delivery Table (MPDT). The LODS 
enables the precise definition of the depth of information contained in the model. 

The American Institute of Architects (AIA) initially introduced LOD in 2008, 
when it defined multiple levels of development to specify detailed levels in a BIM 
model [9]. 

 LOD 100 – Conceptual: A symbol or other general representation of the 
Model Element may be graphically depicted in the Model. Other Model 
Elements can be used to get information about the Model Element. Any 
data derived from LOD 100 elements must be considered approximate; 

 LOD 200 - Approximate Geometry: The Model Element is graphically 
represented as a generic system, object, or assembly within the Model, with 
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approximate quantities, size, shape, location, and orientation. Any data 
derived from LOD 200 elements must be considered approximate; 

 LOD 300 - Precise Geometry: The Model Element is graphically 
represented as a specific system, object, or assembly within the Model in 
terms of quantity, size, shape, location, and orientation Model. The Model 
Element can also have non-graphic data associated with it. The project 
origin has been determined, and the element has been precisely positioned 
to the project origin; 

 LOD 350 - Precise Geometry with Connections: The Model Element is 
graphically represented as a specific system, object, or assembly within the 
Model in terms of quantity, size, shape, location, orientation, and interfaces 
with other building systems. The Model Element can also have non-graphic 
data associated with it; 

 LOD 400- Fabrication-ready Geometry: The Model Element is graphically 
represented within the Model as a specific system, object, or assembly with 
detailing, fabrication, assembly, and installation information in terms of 
size, shape, location, quantity, and orientation. The Model Element can also 
have non-graphic data associated with it; 

 LOD 500 - Operational/As-built Models: The Model Element is a field 
verified representation in terms of size, shape, location, quantity, and 
orientation. Model Elements can also have non-graphic data connected to 
them. 

 

Figure 9 Fundamental Chart of Level of Detail  

(Source: https://www.srinsofttech.com/bim-level-of-development-lod-300-400-500.html) 
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In Italy, the LOD is defined by the UNI 11337-4 of 2017, which states that a 
digital object's level of development is determined by the nature, quantity, quality, 
and stability of the data and information that make up the object. The LOG (Level 
of development of Geometric object attributes) and LOI (Level of development 
of Informative objects attributes) classifications are used. UNI 11337, unlike the 
AIA's five levels, uses an alphabetical scale to identify the LODs: 

 LOD A: the entities are graphically represented using a symbolic geometric 
system or a representation of genre used as a reference with no geometric 
constraints. The quantitative and qualitative features are indicative; 

 LOD B: the entities are graphically simulated as a general geometric system 
or a line geometry. The quantitative and qualitative attributes are 
approximations; 

 LOD C: the entities are graphically simulated into a specific geometric 
system. The qualitative and quantitative features are defined generically 
within the limits of current legislation and reference technical standards, 
and they can be applied to a variety of related entities; 

 LOD D: the entities are graphically simulated as a complex geometric 
system. The qualitative and quantitative qualities are unique to a group of 
similar products. The interface with various specialized construction 
systems is established, as well as the approximate operational and 
maintenance dimensions; 

 LOD E: entities are graphically simulated as a geometric system. The 
quantitative and qualitative features are unique to a single manufacturing 
system that is connected to a certain product. The level of detail for 
production, assembly, and installation, as well as exact measurements for 
maneuverability and maintenance, is specified; 

 LOD F: the objects represent the virtualization of the unique production 
system that was performed/built on-site. The quantitative and qualitative 
features of the product laid and installed are those peculiar to the single 
production system. For each unique product, the management, maintenance 
and/or repair, and replacement actions to be carried out during the work's 
life cycle are defined; 

 LOD G: objects represent the updated virtualization of an entity's actual 
state at a given point in time. For each product, the management, 
maintenance and/or repair, and replacement actions to be carried out during 
the work's life cycle are defined. [34] 
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Figure 10 LOD, UNI 11337 

(Source: allplan.com) 

Information models are made up of a set of qualities as well as geometric data 
(type of elements, materials, characteristics, performance, etc.). As a result, the 
model can be classified according to its graphic detail and information. In 
addition, the inhomogeneity of the definition and content of the LODs, which 
differ by country and standard, is taken into account. These considerations led to 
the introduction of a new definition in ISO 19650 called "Level of Information 
Need," or LOIN, which uses terminology that emphasizes and reiterates, on the 
one hand, the importance of information content regardless of its nature, and on 
the other hand, the need, number, and type of information contained in the model 
are limited to those. 

2.5 Common Data Environment 
BIM is naturally efficient since it brings project partners together to access and 
exchange information through a single database structured with numerous 
interfaces [36]. This environment is referred to as CDE (Common Data 
Environment) in several nations, according to British PAS 1192 regulations. The 
CDE is a virtual environment that allows users to access complete and up-to-date 
project information and is used to improve BIM interoperability [12]. 

According to British Standard BS 1192-2007, a CDE technique should be used to 
allow information to be shared across all project team members. A CDE is 
essentially an online platform where a project team may gather, manage, and share 
information. As a result, the CDE is necessary for more successfully carrying out 
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restructuring, maintenance, and new construction operations, with results that 
meet the quality, time, and cost expectations outlined in the initial plan. 

The data-sharing environment in Italy is known as ACDat (Ambiente di 
Condivisione Dati), and it is defined as follows by art. 2 of DM 560/2017: "A 
digital environment for the organized collection and sharing of data relating to a 
work and structured in information relating to digital models and documents 
primarily attributable to them, based on an IT infrastructure whose sharing is 
governed by precise security systems for access, traceability, and historical 
succession of the changes made to the information contents, of conservation over 
time and relative accessibility of the information assets contained, of the 
definition of responsibilities in the elaboration and protection of intellectual 
property." [13] 

Because this project is a mega project that covers Architecture, MEP, and 
Structural design, it involves various students who have been working on it. The 
CDE platform in this case is Autodesk Docs. 

2.6 BIM and Facility/Asset Management  
Facilities management is a multidisciplinary field that assures the built 
environment's functionality by integrating people, processes, and technology. The 
use of BIM in facilities management is gaining popularity, especially for the aim 
of providing accurate, consistent, and up-to-date building facility information. 
Operation, lease occupancy, maintenance, cleaning, and other FM activities are 
common (BIM DICTIONARY). Facility managers utilize computer maintenance 
management systems (CMMS) to keep their building's information up to date 
[41]. 
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Figure 11 Facility Management 

(Source: https://www.pinterest.com/explore/facility-management) 

Buildings are becoming increasingly complex, necessitating the use of facility 
information to maintain and run them [18]. Such data can be used to properly 
track components, detect inefficiencies in building operations, and respond to 
client requirements [23]. 

Existing facility management and maintenance planning and implementation 
approaches are mostly reliant on the personal experience, expertise, and intuition 
of facility management staff or tradespeople. Typically, facility managers do not 
have access to records that aid them in recognizing or diagnosing problems, 
enhancing their understanding of previous problem histories, or maintenance 
history information for the component they are managing [2]. 

In a review of BIM for sustainability, Chong, Lee, and Wang concluded that BIM 
can help to decrease inefficiencies in existing buildings with real-time FM-
enabled BIM systems to save energy [28]. 

Gao & Pishdad-Bozorgi (2018) observed BIM application trends in building 
operation, maintenance, and repair, as well as limitations in understanding FM 
process workflows and how they relate to BIM [24]. 

Other FM-enabled BIM application areas identified by Bercerik-Gerber et al. in 
their survey include finding building components, simplifying real-time data 
access, checking maintainability, updating digital assets, space management, and 
energy usage control [11]. 
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Although interoperability between software systems has been examined, 
Edirisinghe et al. (2017) analyzed and categorized several research articles, found 
research trends, and concluded that data gathering strategies are still lacking [22]. 

Kassem et al. (2015) investigated the obstacles and benefits of BIM in FM 
applications, concluding that there is a lack of interoperability and standards 
issues that could prevent data from being transferred from BIM to FM systems 
[32]. 

Aziz et al. (2016) examined BIM in FM applications that affect workplace Quality 
Of Life (QOL), concluding that retrieved data might be used and directed to 
complete facility management activities, resulting in long-term advantages [10]. 

Yalcinkaya and Singh (2016a) discussed the research on BIM and FM integration, 
including the background, benefits, and drawbacks of COBie, and, in particular, 
VisualCOBie, a project to improve COBie data display. COBie is a digital facility 
data delivery standard. It was created to address industry issues such as data 
transformation inefficiencies among different disciplines in AEC projects, and 
inadequate user experience when examining and querying facility data, and others 
[50]. 

Hu et al. (2018) emphasized the importance of retrieving MEP system information 
for an accurate assessment throughout the Operation and Maintenance (O&M) 
phase. The authors created an O&M management system that enables the 
digitalization of MEP data for revision and use during the O&M phase [27]. 

Motawa and Almarshad (2013) designed a system architecture to contrast 
information retrieved from a BIM model with a system that captures building 
maintenance information. By supervising the maintenance activities taken on 
existing objects, traceability is available [37]. 

On a database level, Liu and Issa focused on automatic bidirectional interactions 
between Computerized Maintenance Management Systems (CMMS) and BIM 
models. Data can be transmitted bi-directionally between BIM models and the 
CMMS system using operations on the BIM database. A template for bi-
directional data transfer between design and facilities management software was 
created [42].  

Ignatov and Gade looked into how uniform data formatting can help with BIM 
and sensor data management by making it faster, easier, and more realistic. They 
presented a data handling framework that would format and link the various 
datasets into simple and easy-to-read data objects using data conversion and 
mapping methods. They then created a prototype, exhibited BIM and sensor 
database management and linkage, and analyzed and visualized the BIM-
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enhanced and highly dynamic sensor record data in a simulated BMS 
environment. 

Teicholz, P. (Ed.) (2013) defines BIM/FM Integration benefits in his book "BIM 
for facility managers." BIM is widely used in the AEC industry, particularly 
throughout the design and construction phases of a project. The implementation 
of BIM in FM, on the other hand, is not that simple. When FM joins BIM, the 
integration process begins to make the FM process easier. BIM, as a rich database 
container, could provide facility managers with a better approach to process data, 
resulting in a significant increase in work performance [46]. 

 

Figure 12 Summary of the Main Benefits Achieved by BIM/FM Integration [46] 

Four options for BIM/FM integration are presented in the book [46]: 

The first involves entering facility information into a spreadsheet and then 
importing it into a specific FM system. This solution is simple to implement and 
might be used for small projects right away. However, the disadvantages are clear: 
because the data is entered manually without any validation, this strategy has a 
high risk of inaccuracy. 

The second option is to use COBie. COBie defines facility data in each organized 
form, with distinct workbooks representing different facility categories. 

The third method involves using an external link between the BIM and FM 
systems. 
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A fourth alternative is to use the BIM Application Programming Interface (API) 
to directly connect an FM system to a BIM modeling system. This offers a 
dynamic and immediate connection between BIM and FM, allowing BIM data to 
be translated and mapped to the FM system. 

There are also third-party programs available for data transfer. Dynamo is a Revit 
open-source visual programming plugin [20]. In a recent project, Dynamo was 
utilized to extract BIM information for automatic work order scheduling utilizing 
a facilities management system [49]. 

Previous studies and industry implementation have shown that integrating BIM 
with facilities management has numerous advantages. These advantages 
demonstrate the need for successful BIM application in facility management and 
how this can benefit facility owners. The following are some of the benefits and 
interests of utilizing BIM for FM in general [3] [40]: 

 Improved FM efficiency, effectiveness, and speed: This is accomplished by 
giving information that can be exchanged rapidly and efficiently by AECO 
contractors; 

 The results of a more straightforward simulation: For upgrade and 
refurbishment projects, BIM assists in the careful analysis of design and, as 
a result, the easier and more orderly implementation of simulation; 

 Streamlined maintenance: Entering the product and asset information 
required for preventative maintenance is the most difficult part of designing 
a maintenance program. BIM models can save months of work by 
accurately populating maintenance systems with information about 
building equipment; 

 Efficient energy use: Facility managers can utilize BIM technology to study 
and compare various alternative energy sources to reduce the 
environmental effect and operational costs; 

 More cost-effective and simple modifications: The BIM model gives one 
or a few simple procedures for representing a building's three-dimensional 
properties. Information regarding the current state of the building helps 
reduce the cost and complexity of renovations; 

 Building equipment management: Maintain a suitable inventory of building 
equipment using information from the BIM model to avoid the time-
consuming and costly task of creating a coordinated maintenance program; 

 Better space management: With the help of a BIM model, facility managers 
may create inventory space and make optimum use of existing building 
property. This will save money by eliminating excessive expenses; 
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 Building lifecycle management: A model developed by the designer and 
updated over time by the construction phase can be supplied to the owner 
as a 'Built' or 'As Built' model. All specifications, operating and 
maintenance (O & M) manuals, and information assurance will be stored 
in the model, which will be beneficial for future maintenance. This 
eliminates issues that may arise presently if the O & M documentation is 
misplaced or stored in a distant location. 
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3 Information Modeling 

The procedure of developing a digital information model based on parametric 
objects of the underground railway station's HVAC system will be illustrated in 
this chapter. 

3.1 Input Data 
After a preliminary study of the input data, the modeling phase began. The 
Autodesk Docs platform is employed as the data sharing environment, as 
previously stated. Autodesk Docs is a single collaborative platform that provides 
the complete project lifecycle, from design to construction. Members of the 
project team can simply transfer information from one phase to the next, 
maintaining all of the project's information and data in one place [5]. 

 

Figure 13 Data Sharing Environment, Autodesk Docs 

3.1.1 Name Coding 
The name coding of documents and project parameters is a critical part of the BIM 
Execution Plan (BEP) that must be explicitly stated from the beginning. 
Furthermore, all shared material must follow pre-established coding principles to 
promote interoperability. The coding instructions are contained in a text file that 
is accessible to all members of the project team. Table 1 shows the coding process 
and therefore the project file related to this thesis work has been renamed to the 
following:  

TAO_LOM_00_ZZ_M3_M_0001_P00 
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Table 1 Project File Encoding 

TAO Project acronym: TAORMINA 
LOM Responsible organization acronym: Lombardi Ingegneria srl 

00 This indicates that the project is not divided into zones or volumes 
ZZ Multilevel project 
M3 3D model file 
M Discipline: Mechanical 

0001 Indicates the first file in the series 
P00 This indicates that the file has not been validated 

 

3.2 Tools 
BIM software is now broadly applied by a variety of construction organizations, 
both large and small, particularly in the engineering sector. As previously stated, 
the Autodesk Revit 2020 authoring platform was employed for this thesis. 
Architects, landscape architects, structural engineers, mechanical, electrical, and 
plumbing (MEP) engineers, designers, and contractors can utilize Autodesk Revit 
to produce a single model that all disciplines and professions can use to 
accomplish their work. 

To improve data sharing between the project's users, the parametric digital model 
is created on Revit 2020, although Revit 2021 is already available on the market. 
The architectural and structural models had previously been developed in the 2020 
version; it would have been feasible to update them to the 2021 version, but they 
would no longer be convertible to the 2020 version; as a result, it has been decided 
to preserve the 2020 version for the MEP model as well. 

3.3 Template 
The Template is a Revit workspace that includes a set of design settings, families, 
annotations, and labels that define the project in detail [26]. The Revit modeler 
requests that a project template file be opened before beginning a new project. 
The RTE project templates are the starting point for new models since they 
include view templates, loaded families, and further defined settings (such units, 
fill patterns, line styles, line weights, view scales, and more) [7]. 

Default templates can be used or customized templates can be created. To be 
consistent with the rest of the design, the same customized templates that were 
produced for modeling the other facilities in the same railway project were used 
in this thesis. The company's architects and engineers have already prepared 
STD_LOM_00_ZZ_TE_FMEP_0001_P00.rte, a basic customized template for 
ventilation and air conditioning systems. 
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In the next sections, the template setup allows for the defining of rules and specific 
details. 

3.3.1 Revit links 
The templates for all disciplines are available in the CDE, inside the folder 
containing the Revit files. It was decided to link Revit models with shared 
coordinates to be consistent with the architectural structural model and to make 
MEP modeling activities easier. The first step is to link the architectural structural 
design by selecting the architectural structural template from the Insert menu > 
Link Revit. In the dialog, it is required to select the name and type of the desired 
file to link and the desired option among the available ones related to the 
positioning. By clicking on Insert > Manage Links or on Manage > Manage Links, 
a tab opens, Figure 16, which allows to view all the files link and modify some 
properties. 

 

Figure 14 Link Revit, Revit 

 

Figure 15 Import/Link RVT, Revit  
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Figure 16 Manage Links, Revit 

3.3.2 Shared Coordinates 
Once the architectural structural model is connected, the coordinates are acquired 
by going to Menu > Manage > Coordinates > Acquire Coordinates. The 
acquisition of coordinates allows to determine the coordinates used in a linked 
project, and use them for the current project, this means that the origin of the 
linked project’s shared coordinates becomes the origin of the host project’s shared 
coordinates. 
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Figure 17 Acquire Coordinates, Revit 

3.3.3 Workset 
A workset is a collection of elements in a project that is widely shared. Revit 
facilitates collaboration between experts working on the same project by allowing 
them to work on the same project at the same time. Each workset can only be 
edited by one person at a time. Worksets can be viewed by all team members, 
including those owned by others, although they cannot always be modified. This 
eliminates the possibility of internal dispute inside the project. 

To make a workset in Revit, go to Collaborate > Workset and select New. From 
there, we can make as many worksets as we want. We can also view the current 
one and make changes if necessary in the collaborate section. 

 

Figure 18 Workset, Revit 

3.4 Parametric Family 
All of the elements that can be added to a 2D or 3D project are called Revit 
families. Families are divided into three categories in Revit: 

 System Families 
 Loadable Families 
 In-place Families 
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The system families include foundations, pillars, beams, floors, roofs, and 
staircases, among other structural elements. They are not loaded from external 
files because they are predefined in Revit and saved in templates and projects. 
Through the Architecture, Structure, Steel, and Systems tabs, system families can 
be added to the project. 

All non-structural elements, such as doors, windows, and plants, are considered 
as loadable families. Loadable families can be obtained in the Revit libraries, on 
the Internet, or created from scratch in the Family Editor. 

The in-place families are those who are specifically assigned to a project. The 
loadable families can be used in numerous projects, however, the in-place families 
can only be utilized in the original project. In-place elements can increase file size 
and degrade software performance. 

A default loadable family library can be inserted and possibly updated in Revit. 
Simply select Insert> load Family to insert a default family (Figure 19).  Once the 
family of interest has been selected, the Open button allows loading the family 
into the project. Hence, the family type is available to place in the project and 
displays in the appropriate category under Families in the Project Browser. 

 

Figure 19 Load Family, Revit 
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If the default families do not meet the requirements, there is the possibility to 
create the families that can be loaded by clicking on File > New > Family (Figure 
20). 

 

Figure 20 New Family, Revit 

Revit allows choosing between different types of families, for example, to model 
the damper or silencer we start with a family based on mechanical equipment, 
while some families are modeled as a generic metric and then are assigned to the 
correct category to which they belong. All families are created as parametric 
elements, this means that the geometric dimensions are variable type parameters. 
Once a family is created, many types of the same can be generated as the 
dimensions vary. Within the project, there are different types of mechanical 
equipment. We will analyze in detail some of these types to highlight their 
criticalities. 

3.4.1 Ventilator 
The ventilation system has centrifugal fans as its source. There are three 
ventilation systems positioned in the room. These systems belong to the family: 

TAO_LOM_M_Mechanical Equipment_Ventilator 
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Table 2 Ventilation Encoding 

TAO Project acronym: TAORMINA 
LOM Responsible organization acronym: Lombardi Ingegneria srl 

M Discipline: Mechanical 
Mechanical Equipment Revit category: Mechanical Equipment 

Ventilator Type of object: Ventilator 
 

 

Figure 21 Isometric View of Ventilator, Revit 

 

Figure 22 Front View of Ventilator, Revit 
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Figure 23 Front View of Ventilator, Revit 

When finished, this family is inserted in the category of mechanical 
equipment. Once saved and loaded in the project, it is possible to place the 
ventilation systems in the model.  

3.4.2 Silencer 
In the project, there are two silencers located in front and behind the ventilators. 
These systems belong to the family: 

TAO_LOM_M_Mechanical Equipment_Silencer 

 

Table 3 Silencer Encoding 

TAO Project acronym: TAORMINA 
LOM Responsible organization acronym: Lombardi Ingegneria srl 

M Discipline: Mechanical 
Mechanical Equipment Revit category: Mechanical Equipment 

Silencer Type of object: Silencer 
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Figure 24 Isometric View of Silencer, Revit 

 

Figure 25 Top View of Silencer, Revit 

When finished, this family is inserted in the category of mechanical 
equipment. Once saved and loaded in the project, it is possible to place the 
silencers in the model.  

3.4.3 Damper 
There are some dampers with different dimensions in the project. These systems 
belong to the family: 

TAO_LOM_M_Mechanical Equipment_Damper_1700_1900 

TAO_LOM_M_Mechanical Equipment_Damper_2250_3500 

TAO_LOM_M_Mechanical Equipment_Damper_2250_4000 

TAO_LOM_M_Mechanical Equipment_Damper_2600_3300 
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Table 4 Damper_1700_1900 Encoding 

TAO Project acronym: TAORMINA 
LOM Responsible organization acronym: Lombardi Ingegneria srl 

M Discipline: Mechanical 
Mechanical Equipment Revit category: Mechanical Equipment 

Damper Type of object: Damper 
1700 Length of damper 
1900 Width of damper 

 

 

Figure 26 Isometric View of Damper_1700_1900, Revit 

 

Figure 27 Front View of Damper_1700_1900, Revit 
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Figure 28 Isometric View of Damper_2250_3500, Revit 

 

Figure 29 Front View of Damper_2250_3500, Revit 

 

Figure 30 Isometric View of Damper_2250_4000, Revit 
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Figure 31 Bottom View of Damper_2250_4000, Revit 

 

Figure 32 Isometric View of Damper_2600_3300, Revit 

 

Figure 33 Front View of Damper_2600_3300, Revit 
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When finished, this family is inserted in the category of mechanical 
equipment. Once saved and loaded in the project, it is possible to place the 
dampers in the model.  

3.4.4 Duct Modeling 
Some ducts with diameters ranging from 500, 600, 700,...1500 millimeters are 
also included in the project. The best work is to check the "Show Disconnects" 
option while drawing the ducts, as this helps to identify whether there is a problem 
in the duct system that prevents the system from being closed. When attempting 
to link two elements, these problems can happen due to a disconnection or 
inconsistency among systems. This tool can be found on the Check Systems panel 
of the Analyze tab. 

 

 

Figure 34 Show Disconnects, Revit 

As a result, duct elements are created. Duct elements belong to the “Duct” 
category, where all families correspond to the System Families type. Only types 
can be created, modifying some settings such as the routing preferences. Routing 
preferences allow the selection of the default duct fittings that will be placed 
during the use of this type of duct. It is possible to load the required duct fitting 
families from the libraries since they are loadable families. Some other settings 
can be also customized: Elbow, Preferred Junction Type, Cross, Transition, 
Union, and Cap. These settings are saved into the Revit model. 



38 
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Figure 35 Routing Preferences, Revit 

 

 

Figure 36 Ducts, Revit 
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Figure 37 Ducts with Different Diameters, Revit 

3.5 Parameters 
The importance of information in a BIM project cannot be overstated. The non-
geometric information content of a family is indicated by the Level Of 
Information, which is commonly abbreviated as LOI. Data sheets, manufacturing 
specifications, and maintenance instructions, for example, may be included in a 
family with a high level of information. Custom parameters for a project and any 
category of elements or components can be created in Revit. The parameters 
created are visible in the properties dialog of the type or the property palette, 
depending on whether they are of type or instance, in the selected group. There 
are different types of parameters: 

 Global parameters; 
 Shared parameters; 
 Project parameters; 
 Family parameters. 

Global parameters are project-specific parameters that are not related to any 
category. They can be simple values, values derived from formulae, or even model 
parameters derived from other global parameters. 

Parameter definitions that can be used among numerous families and projects are 
known as shared parameters. It is possible to use a new shared parameter as a 
family or project parameter after entering it. The parameters that are provided can 
be tagged and scheduled. A schedule is a table that displays information taken 
from the properties of project elements. Schedules in Revit are highly valuable 
tools, and they may also be exported to other programs, such as a spreadsheet. 
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The project parameters are also unique to a single project, just like the global 
parameters. The information included inside these types of parameters cannot be 
shared with other projects, but they can be used to create schedules, order them, 
and create filters. 

Family parameters are particular family settings that can also be used to manage 
nested family parameters by linking the host family parameter to the nested family 
parameter. 

To create a family parameter, open the family wanted to associate with the 
parameter, click on the Family Types icon and create the new parameter (Figure 
38). 

 

Figure 38 Family Types, Revit 

3.6 Materials 
The choice of materials is made for visual and not qualitative purposes, it must be 
specified which materials have been created that identify the system. Inside the 
HVAC model, there is a supply air system of different sizes. To assign a material 
to a system, (Figure 39), just click on Manage > Materials. 
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Figure 39 Material Browser, Revit 

3.7 Results 
In conclusion, at the end of the modeling phase, a three-dimensional HVAC 
system is obtained. 
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Figure 40 Isometric View Model, Revit 
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Figure 41 Front View Model, Revit 
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Figure 42 Top View Model, Revit 

 



46 
 

 

 

 

 

 

Figure 43 Section 2, Revit 
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Figure 44 Section 5, Revit 
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Figure 45 Section 7 , Revit 
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4 Development of BIM Model for Facility/Asset Management 

In this chapter, it will be illustrated the development of the BIM model 
(management and maintenance) of the underground railway station. 

4.1 Interference Check 
3D analysis and interference control are activities that exploit graphic information 
of the objects in the model and the relationships between them. The BIM model 
must contain the representation of the work in its entirety (from architectural 
works up to the systems) and therefore it is necessary to coordinate all the parts 
between them to avoid interference. In general, coordination and clash detection 
activities are carried out in the design context to avoid the propagation of these 
errors in the construction phase of the work. So, the clash detection allows 
controlling and especially solve the problems of overlapping and interference that 
are created inside of the federated model, generated by the coordination of the 
various disciplinary models, like architectural, structural, and plant engineering.  

4.1.1 Data Collection 
Once the 3D information model is obtained, it is possible to export each model 
from Revit in an appropriate format to be opened by another software. To check 
any interferences or errors between the elements of the model, it is necessary to 
export the model generated on Revit to the Navisworks NWC file. In this case, 
each of the two files is exported to the NWC. To export the project from Revit, 
go to File > Export > NWC to obtain the model in NWC (Figure 46).  
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Figure 46 Export to NWC from BIM Authoring Platform 

4.1.2 Software 
For static and dynamic interference checking, it is used the Autodesk Navisworks 
Manage software, the 2020 version. This program allows the identification and 
management of problems caused by conflicts and interference before the 
construction of the work. With Navisworks, it is possible to create renderings of 
the photorealistic model, create simulations and animations of the model, etc. 
Also, the software can produce a list of all interferences detected in the project, 
verifying the presence of temporal and spatial coordination [6]. 

4.1.3 Import disciplinary models 
As described before, the use of model checking is essential especially in the 
coordination, control, and verification phase. It allows to identify any 
interferences in the model and correct them in a good time to reduce the risk of 
changes in progress that would be more costly and time-consuming. 

To be able to do a Clash Detection on Navisworks, first, it is necessary to add all 
the disciplinary models (architectural, structural, ventilation, and fire prevention 
systems) previously converted from Revit in the NWC format. In our case, the 
ventilation and fire prevention systems are added. Just click on Append and select 
the desired files to import (Figure 47). 



 

51 
 

 

Figure 47 Add NWC, Navisworks 

 

Figure 48 3D Model, Navisworks 

4.1.4 Clash Detection 
This section enables to perform a clash detection considering several parameters 
and different kinds of clashes. For clash detection, select Clash Detective from 
the top menu. The tests of interference are created by clicking on Add Test (Figure 
50). So it is possible to check static interference between systems. The following 
procedures must be followed:  
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 Rename the test (for example “M vs PFP” corresponds to the control of the 
interference between the ventilation system model and the firefighting 
one); 

 Choose the two files to compare. Remember that it is also possible to check 
for interference between two elements/objects; in this case, it is necessary 
to select the two or more interested parties; 

 Change the settings (Figure 50). We have chosen to use the type 
“Clearance”, Tolerance equal to 0.001 m and “None Link”; 

 At this point, it is possible to click on Run test and it will automatically 
appear clash detection results. 

The results are shown in Figure 50. Some interferences arise when two objects 
are physically in conflict with each other. These types of clashes need to be solved 
early on phases, moving or replacing the elements causing the conflict. 

Once the test has been completed and the results have been viewed, we can 
download the report of the clash detection in “HTML” format by clicking on 
“Write Report” (Figure 52). 

 

Figure 49 Clash Detective, Navisworks 

 

Figure 50 Clash Detection, Navisworks 
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Figure 51 Clash Detection Result Example, Navisworks 

 

Figure 52 Interference Report, Navisworks 
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To insert a comment regarding any interference found, just click with the right 
mouse button on the desired interference and choose to Add a Comment. In Figure 
53 an example of a comment referring to the interference found in Figure 51 is 
shown. 

 

Figure 53 Comment Example, Navisworks 

As we will see in Figure 52, there are a total of 15 clashes between the elements. 
These types of clashes need to be solved, moving, or replacing the elements 
causing the conflict. After modifying the model and running another clash 
detection, there are not any interferences at all (Figure 54) .  

 

 

Figure 54 Clash Detection after Modifying the Model, Navisworks 
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4.2 Integration BIM-BMS Using Dynamo  
Dynamo is an open-source visual programing language for Revit, written by 
designers and construction professionals, and aims to be accessible to both non-
programmers and programmers alike. Dynamo can be added as a plug-in into 
Revit. In Dynamo, nodes are the objects we connect to form a Visual Program. 
The nodes in Dynamo are Python scripts that have assigned a particular task that 
may range from a simple operation to the creation of geometry [38]. 

Most nodes in Dynamo are composed of 5 parts. The anatomy of every node may 
be described as follows (Figure 55): 

 Name - This is the name of the node that has a category; 
 Main - The Node's main body - Right-clicking here brings up choices at the 

Node's overall level; 
 Ports (In and Out) - The Wire receptors that give the Node with input data 

as well as the consequences of the Node's actions; 
 Lacing Icon - The Lacing option for matching list inputs is indicated by this 

icon; 
 5. Default Value - Right-click an input Port; certain Nodes have default 

values that may or may not be used. 

 

Figure 55 Anatomy of a Node, Dynamo  

(Source: https://primer.dynamobim.org/03_Anatomy-of-a-Dynamo-Definition/3-
1_dynamo_nodes.html) 

4.2.1 Dynamo for Exporting Data 
In the first step, Dynamo is employed to access the BIM database and extract any 
data required by the BMS. This data is then processed and converted to JSON 
strings. JSON data proves easy to convert to, organize, combine, and parse. In this 
case, a Dynamo script is developed to extract Revit parameters from different 
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Revit Categories. The main idea is to pass these parameters into the JSON format 
to integrate with BMS.  

To easier understand the process realization, the whole script has been divided 
into different groups with a different task for each group (Figure 56). 

 

Figure 56 Dynamo Script for Ducts, Dynamo 

Gray Groups: this group is related to the input information. This is a list of how 
we can get categories from the project. The way we can extract the information 
from the model is by using categories and selecting a category. We can use the 
node “Categories” and select a category like “Ducts”. Then, we can extract all the 
elements of a specific category using the second node “All Elements of Category”.  

 

Figure 57 Gray Groups, Dynamo 
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Green Groups: by providing a list of elements, we want to extract specific 
parameters from the elements and then create a report of elements that we want 
to export into a JSON file. The first thing we need is the node 
“Element.GetParameterValueByName”. for example, if we want to extract the 
“Level” information, we can go and find how the parameter is called for ducts, so 
we must find the right information. In this case, we use a node “Code Block” and 
write “Reference Level” as a parameter name, the same name in Revit.  After Run, 
we have a list of levels, exactly what we need. Then to extract the level name, we 
need to use another node which is “Element.Name”, so after this one, we have a 
string with a level name.  

Also, we need to understand the “Diameter” of elements, so we use another node 
which is “Element.GetParameterValueByName”. Here, we write “Diameter” in 
the node “Code Block”. After Run, we have a list of diameters. We do the same 
way to extract “Length”, and “Area” of elements.  

To extract Element Name, we can use a node “Element.Name”, after Run we have 
a list of the element name.  

To extract Element Id, there is a node “Element.Id”. In this case, we have an Id of 
elements as an integer, but we need this one as a string, so we can convert an 
integer number into a string. Here we use a node “String from Object” that is 
doing exactly this operation. The Element Id is a kind of information that we 
would like to have back into the project because we can use this information to 
keep track of the elements later, so the Element Id is important.  

Finally, we also need to know the location of elements. To do that, we create a 
project parameter or shared parameter “Location” in Revit which says that in the 
plan we have several sections with a range from a to c, so in this way, we can 
understand from that parameter which is the location of that specific element. In 
this case, we use a node “Element.GetParameterValueByName” and after Run, 
we have a list of locations. 
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Figure 58 Location, Project Parameters, Revit 

 

Figure 59 Green Groups, Dynamo 
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Orange Groups: We can create two new project parameters or shared parameters 
called “Element Id” and “Element Level” which are instance parameters. To do 
that, in Revit click on Manage > Project Parameters > Add. So, we have two new 
parameters, but they are empty. We can write this information back to the 
elements, to do that, there is another node “Element.SetParameterByName” 
where we can say that the element where we want to write information is the same 
element from where we are reading information.  

In summary, the workflow is to first select all elements, and connect elements to 
get the Element Id of each element, then convert this integer value into a string 
value and use the same value to write this into a new parameter which is a project 
parameter. To do that, we need a list of elements and to be sure that we are using 
the same elements to extract and to write back information, then we must connect 
this information to the same elements. It is important to know that this information 
cannot be a Type Parameter because it is changing every time, so it should be 
always an Instance Parameter. If click Run, we will have all Ids back into each 
element inside Element Id information. We do also the same thing for “Element 
Level”, and after Run, the value of Element Level is available now.  

 

Figure 60 Element Id, Project Parameters, Revit 

 



60 
 

 

Figure 61 Orange Groups, Dynamo 

Blue Groups: We can use tools in Dynamo to export this information directly to 
JSON format. To do that, first, we download a package called JsonData from the 
Packages menu.  It has several nodes to perform different functions, but the main 
one is to create the base structures of the JSON format: JsonObject. A JsonObject 
is the representation of the key/value pair structure of the JSON format. They will 
be created by using the node “JsonObject.ByKeysAndValues”, which returns a 
brand-new instance of a JsonObject. In this node, for the keys, we create a list 
with a node called “List Create” and put all the parameters that we want to export 
like “Element Id”, “Element Name”, “Level”, “Diameter”, “Length”, “Area”, and  
“Location” in a node “Code Block”.   For the values, we also create a list with a 
node called “List Create” and put all the parameters coming from the green groups 
which are the real information. Here, we do not need to connect the orange groups 
because they are information that is being used to write back into Revit. There is 
a node called “List.Transpose” to make a list of columns that we actually need.  

Finally, to export this information directly to JSON format, we use a node called 
“Write.ToJsonFile”. in this node, we need jsonObjects that are already created 
and a file path. The file path is the name of the JSON file. To do that, we need to 
use a “File Path” node, then we can click on Browse and choose the file name. It 
is important to remember that we must write the entire file name with the name 
of the file and extension of the file and then connect it to the filepath.  
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Figure 62 JsonData Package, Dynamo 

 

Figure 63 Blue Groups, Dynamo 

If we need to export something else, such as duct fittings or mechanical 
equipment, we may follow the same steps, starting with selecting "Duct Fittings" 
or "Mechanical Equipment" from the element Categories. The related workflow 
is shown in Figures 64, 65. 
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Figure 64 Dynamo Script for Duct Fittings, Dynamo 

 

Figure 65 Dynamo Script for Mechanical Equipment, Dynamo 

4.3 Results 
After Run, we have all the information in JSON string.  
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Figure 66 JSON String for Ducts 

 

Figure 67 JSON String for Duct Fittings 
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Figure 68 JSON String for Mechanical Equipment 
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5 Conclusion and Future Developments 

In conclusion, this thesis work has dealt with several issues whose main theme 
turns out to be the BIM methodology. It can be said that the present thesis was 
aimed at obtaining a digital information model with all the data necessary for the 
management and maintenance of the ventilation system belonging to the railway 
line infrastructure. There have been some problems related to the interpretation of 
the .pdf files because in certain situations there were discordant data regarding the 
dimensions of the elements, but in any case, they were then resolved during the 
modeling. 

In this study, the author tried to explore how to put a relation like a JSON file in 
the link between BIM and BMS environment. In another word, the main focus is 
to exchange information from BIM model to use this information and put them in 
communication with building monitoring system, so if there is something that is 
happening to the physical asset for example a failure or damage, this information 
is then sent back into BIM model, and the user that has to control and check if 
everything is working properly, can use the model to identify problems and then, 
for instance, open a ticket for maintenance activities. The author tried to define 
how the BIM model could be in communication with BMS system by using JSON 
language. 

Simple data interchange formats, such as JSON, provided an advantage in the 
speed of the data extraction and analysis in the contemporary BMS, especially 
when handling large amounts of dynamic datasets. This thesis will contribute to 
the idea by demonstrating a successful link and exchange of useful BIM data 
between platforms, using JSON, while still retaining the ontology of the building 
information models. This will help for a more useful database through semantic 
queries. Hence, the methodological approach for the information model was 
aimed at being connected with building management systems.  

So, in this case, we need a middleware, a kind of platform that is integrating 
information coming from both building information models and building 
management systems. The author tried to export information in JSON format, but 
we need to go further. Therefore, further developments include creating a platform 
and putting in relation with data. In this case, we put those frameworks where we 
can have BIM, BMS, and CMMS platforms. So, we can use these frameworks to 
give some possible solutions or approaches. Also, different methods regarding 
web- or cloud-based BIM data transfer and storage can be used for future 
developments in this area. 

 



66 
 

References 

[1] Afsari, K., Eastman, C. M. and Castro-Lacouture, D. (2017) JavaScript Object 
Notation (JSON) data serialization for IFC schema in web-based BIM data 
exchange. Automation in Construction, 77. pp. 24-51. 

[2] Akcamete, A., Akinci, B., and Garrett, J. H., Jr. (2010) “Potential utilization 
of building information models for planning maintenance activities,” Proceedings 
from The International Conference on Computing in Civil and Building 
Engineering Nottingham, UK, June 30-July 2, 2010. 

[3] Alan, E. (2007). BIM Implementation Strategies. National BIM Standard 
Committee. 

[4] Alexander, K. (1996). Facilities Management: Theory and Practice, E&FN 
Spon, New York. 

[5] Autodesk, "Construction Management Sofrware|Autodesk BIM360. Available 
online: https://www.autodesk.com/bim-360/. 

[6] Autodesk, «Navisworks Manage,» 2020. [Online]. Available online: 
https://www.autodesk.it/products/navisworks/overview. 

[7] Available online: https://knowledge.autodesk.com. 

[8] Available online: https://knowledge.autodesk.com/support/revit-
products/learn-explore/caas/CloudHelp/cloudhelp/2021/ENU/Revit-
Customize/files/GUID-4C16B54A-7ADA-4DEB-A278-C199B1BC4207- 
htm.html. 

[9] Available online: https://www.united-bim.com/bim-level-of-development-
lod-100-200-300-350-400-500. 

[10] Aziz, N. D., Nawawi, A. H., & Ariff, N. R. M. (2016). Building Information 
Modelling (BIM) in Facilities Management: Opportunities to be Considered by 
Facility Managers. Procedia - Social and Behavioral Sciences. 
https://doi.org/10.1016/j.sbspro.2016.10.252. 

[11] B. Becerik-Gerber, F. Jazizadeh, N. Li, and G. Calis, “Application Areas and 
Data Requirements for BIM-Enabled Facilities Management,” 2012. 

[12] BibLusBIM, "BIM management: il CDE (Common Data Environment). 
Available online: http://bim.acca.it/bim-management-il-cde-common-data 
environment. 

[13] BibLus-net,"ACDat (ambiente condivisione dati). Available online: 
http://biblus.acca.it/focus/acdatambiente-di-condivisione-dati. 



 

67 
 

[14] Bilal Succar. Building information modeling framework: A research and 
delivery foundation for industry stakeholders. Automation in construction, 
18(3):357–375, 2009. 

[15] BuidingSMART International, "Industry Foundation Classes (IFC)". 
Available online: https://www.buildingsmart.org/standards/bsi-
standars/industryfoundation -classes. 

[16] C. Eastman, P. Teicholz, R. Sacks and K. Liston, BIM HANDBOOK A 
Guide to Building Information Modeling, Jhon Wiley & Sons Inc, 2008. 

[17] David Chapman, Stylianos Providakis, Christopher Rogers, "BIM for the 
Underground - An enabler of trenchless construction," Department of Civil 
Engineering, University of Birmingham, 2019. 

[18] D. A. Jordani, “BIM and FM: The Portal to Lifecycle Facility Management,” 
Journal of Building Information Modeling (JBIM), 13 – 16. 

[19]Designing Buildings. (2018, March 22). Designing Buildings Wiki. Retrieved 
from  
https://www.designingbuildings.co.uk/wiki/Mechanical,_electrical_and_plumbi
ng_MEP.                                                        

[20] Dynamo, Autodesk Inc. Available from: https://dynamobim.org. 

[21] Eastman, C. (1999). Building Product Models: Computer Environments 
Supporting Design and Construction, CRC Press LLC, Florida. 

[22] Edirisinghe, R., London, K. A., Kalutara, P., & Aranda-Mena, G. (2017). 
Building information modeling for facility management: Are we there yet? 
Engineering, Construction and Architectural Management, 24(6), 1119–1154. 
https://doi.org/10.1108/ECAM-06-2016-0139. 

[23] Forns-Samso D.F. (2010). The perceived value of building information 
modeling in facilities operations and maintenance (Master’s Thesis) Available 
from ProQuest Dissertations and Theses database. 

[24] Gao, X., & Pishdad-Bozorgi, P. (2018). Past, Present, and Future of BIM-
Enabled Facilities Operation and Maintenance. Proceeding of Construction 
Research Congress 2018, 2010(1), 148–157. 
https://doi.org/10.1213/01.ANE.0000149897.87025.A8. 

[25] Gerrish, T., Ruikar, K., Cook, M., Johnson, M., Philip, M., and Lowry, C. 
(2017). BIM application to building energy performance visualization and 



68 
 

management: Challenges and potential. Energy and Buildings. 144. pp. 218-228. 
doi: https://doi.org/10.1016/j.enbuild.2017.03.032. 

[26] Graitec, "The Template of the Autodesk REVIT". Available online: 
www.graitec.it. 

[27] Hu, Z. Z., Tian, P. L., Li, S. W., & Zhang, J. P. (2018). BIM-based integrated 
delivery technologies for intelligent MEP management in the operation and 
maintenance phase. Advances in Engineering Software. 
https://doi.org/10.1016/j.advengsoft.2017.08.007. 

[28] H. Y. Chong, C. Y. Lee, and X. Wang, “A mixed review of the adoption of 
Building Information Modelling (BIM) for sustainability,” Journal of Cleaner 
Production. 2017. 

[29] INGENIO-WEB, "Perché scegliere di progettare BIM-MEP: il punto di vista 
di chi lo usa ogni giorno". Available online: https://www.ingenio-web.it/20070-
perchescegliere-di-progettare-bim-mep-il-punto-di-vista-di-chi-lo-usa-ogni-
giorno. 

[30] Institution of Civil Engineers, Civil Engineering Procedure, 978-0-7277-
6069-2, Available online: http://dx.doi.org/10.1680/cep.60692.131. 

[31] J.Wang, X.Wang, W.Shou, H-Yih Chong, J.Guo, Building information 
modeling-based integration of MEP layout designs and constructability, 
ELSEVIER, 2016. 

[32] Kassem, M., Kelly, G., Dawood, N., Serginson, M., & Lockley, S. (2015). 
BIM in facilities management applications: a case study of a large university 
complex. Built Environment Project and Asset Management, 5(3), 261–277. 
https://doi.org/10.1108/BEPAM-02-2014-0011. 

[33] Liu, X., & Akinci, B. (2009). Requirements and Evaluation of Standards for 
Integration of Sensor Data with Building Information Models. Computing in Civil 
Engineering (2009). 

[34] Matteo Del Giudice, Il disegno e l’ingegnere – BIM handbook for building 
and civil engineering students, Levrotto & Bella 2019. 

[35] M.Cassano, M.L.Traini, LOD standardization for construction site elements, 
Politecnico di Milano, Procedia Engineering 196(2017)1057-1064, 2017. 

[36] M.Hooper, BIM Anatomy II: Standardisation Needs and Support Systems, 
Lund University, 2015. 



 

69 
 

[37] Motawa, I., & Almarshad, A. (2013). A knowledge-based BIM system for 
building maintenance. Automation in Construction. 
https://doi.org/10.1016/j.autcon.2012.09.008. 

[38] Mousiadis, T., & Mengana, S. (2016). Parametric BIM: Energy Performance 
Analysis Using Dynamo for Revit. Royal Institute of Technology. Retrieved from 
www.kth.se. 

[39] NIBS. United states national building information modeling standard, 
version 1-part 1: Overview, principles, and methodologies, 2008. 

[40] Pinsent Masons (2013). Building Information Modeling. Available online: 
http://www.out-law.com/en/topics/projects--construction/projects-and-
procurement/building-information-modelling. 

[41] P. Pishdad-Bozorgi, X. Gao, C. Eastman, and A. P. Self, “Planning and 
developing facility management-enabled building information model (FM-
enabled BIM),” Autom. Constr., vol. 87, pp. 22–38, Mar. 2018. 

[42] Rui Liu, Raja R A Issa, “Automatically Updating Maintenance Information 
from a BIM Database,” Conference Paper · June 2012. 

[43] Sabol, L. (2008). Building Information Modeling & Facilities Management. 
Design and Construction Strategies, IFMA World Workplace, November 2008. 

[44] Smart Building Italia, "Modello MEP e modello architettonico in un unico  
ambiente BIM". Available online: 
https://www.smartbuildingitalia.it/news/bimtecnologia/modello-mep-e-modello-
architettonico-in-unico-ambiente-bim. 

[45] Tang, S., Shelden, D. R., Eastman, C. M., Pishdad-Bozorgi, P. and Gao, X. 
(2019). A review of building information modeling (BIM) and the internet of 
things (IoT) devices integration: Present status and future trends. Automation in 
Construction. 101. pp. 127-139. doi: 
https://doi.org/10.1016/j.autcon.2019.01.020. 

[46] Teicholz, P. (Ed.). (2013). BIM for facility managers. John Wiley & Sons. 

[47] Tobias, M. (2018, December 6). Retrieved from New York Engineers Web 
Site: https://www.nyengineers.com/blog/what-does-mep-mean-in-construction. 

[48] UNI, UNI 11337-1, UNI, UNI 11337-4. 

[49] W. Chen, K. Chen, J. C. P. Cheng, Q. Wang, and V. J. L. Gan, “BIM-based 
framework for automatic scheduling of facility maintenance work orders,” 
Autom. Constr., vol. 91, pp. 15–30, Jul. 2018. 



70 
 

[50] Yalcinkaya, M., & Singh, V. (2016). Evaluating the Usability Aspects of 
Construction Operation Building Information Exchange (COBie) Standard. In 
CIB World Building Congress, at Tampere, Finland 
https://www.researchgate.net/publication/303811016_Evaluating_the_Usability 
Aspects_of_Construction_Operation_Building_Information_Exchange_COBie_
Standard. 

[51] Z-Zhong Hu, P-Long Tian, S-Wei Li, J-Ping Zhang, BIM-based integrated  
delivery technologies for intelligent MEP management in the operation and 
maintenance phase, ELSEVIER, 2018. 

 


